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Chapter

1

Welcome to DIWE
Welcome to the Daedalus® Integrated Writing Environment (also known as
DIWE) from the Daedalus Group, Inc.  DIWE is designed for writing instruction,
collaboration, and communication among students and teachers in all curricula.
This Instructor's Guide provides you with theoretical and practical pedagogical
support for using the Daedalus Integrated Writing Environment.

This guide explains how to install, set up, and manage DIWE at a site.  The in-
stallation details in this guide repeat the information in the Installation Guide
which is distributed with Installation diskettes.

• What is DIWE?* overviews the components which comprise DIWE and the
ways DIWE affects the teacher and student in the computer-based class-
room.

• Program Documentation* outlines the print and online help files which are
available with the software.

• Installing DIWE* explains how to install the software on individual worksta-
tions and your network server.  This section also includes details on how to
determine which resources you need to install at your site and explains the
possible network configurations you can choose for your site.

• Checking File Structure describes the files and folders used by the program.

• Setting Network Permissions* outlines how to set folder and file permissions
for your workstations and server, and includes details on other security issues.

• Printing Program Documentation* explains how to print and distribute the
three guides which accompany the program.

• Setting Up Your Site provides instructions for setting up new classes, choos-
ing preferences for your site, managing your site by modifying classes and in-
formation on teachers and students, and setting up a new semester.

                                                
* These sections duplicate information available in the Installation Guide which is shipped in printed
form with DIWE's Installation diskettes.

In This

Guide
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• Troubleshooting includes details on the error messages which can appear in
the program and provides step-by-step instructions on resolving questions
and improving the software's performance.

• Getting Help outlines the additional resources available to teachers and
technicians working with DIWE, including details on how to contact the
Daedalus Group for answers to your questions about the software.

Finding Other Program Information

If you need to know more about how to use any of the tools in DIWE, please
consult the User's and Instructor's Guides.

If you need instructions on managing Class Assignments, Mail and InterChange
conferences, and turned in documents, see the Instructor's Guide.

Conventions used in this document
Courier font indicates text that is displayed or typed on the screen

Boldface signals menu commands and button commands.

Italic font represents information that you will have to provide.  If asked to
type yourfilename, you might type PAPER1

<Key> refers to an actual control key on your keyboard.  

<Key1+Key2> indicates that two keys should be pressed together.  For in-
stance, when instructed to press <Alt+F9>, you would press (and hold)
the <Alt> key and press the <F9> key.  

Although the software is referred to by its full name (the Daedalus Integrated
Writing Environment) most of the time, it is often shortened to DIWE to keep
things simple.  
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Chapter

2

What Is DIWE?
DIWE, the Daedalus Integrated Writing Environment, is award-winning computer
software, developed by writing teachers for writing teachers and used by students
in hundreds of schools, ranging from middle school to four-year universities.

Writing and Thinking Tools

DIWE is an integrated package of writing / thinking tools designed with the class-
room in mind.  The program focuses on teaching and learning by means of
(often interactive) written discourse — encouraging collaborative work, critical
thinking skills, and communication.  DIWE is comprised of these six modules,
each designed to address a specific task or stage of producing a piece of writing:

Invent

Invent stimulates writers to explore their topics and to
think divergently.  The tool allows writers to save and print
out the text to help them generate first drafts. Teachers
can compose their own Invent questions to supplement
the twelve standard sets which come with the software.

Write

Write is a streamlined word processor which allows
teachers to teach writing, not word-processing.  It includes
all basic operations (copying, pasting, spell-checking,
printing) for writers to produce and revise drafts.

Respond

Respond allows writers to call up drafts and other
documents for on-line analysis and review.  Writers can
save and print their text to use as they work on other as-
signments.  Prompts can be modified to suit the assign-
ment, ranging from peer review to document analysis.

Mail

Mail acts as the central switchboard for class communi-
cations, from private mail to group work.  Date, time, and
receipt stamps make it an effective class management
tool.  
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InterChange®

InterChange enables synchronous, or "real-time"
discussions for whole classes or small groups.  Transcripts
of these discussions are recorded and are available for
viewing and printing.  

BiblioCite®

BiblioCite prompts writers to record bibliographic en-
tries and maintains them in a database of sources.  It
generates a Works Cited page in MLA style or a Refer-
ences Page in APA style.

Class and Document Management Tools
In addition to the six modules, DIWE includes class and document management
tools which streamline the process of sharing documents and distributing hand-
outs as well as allow the teacher to customize the content to fit the class.

Class
Assignment

Class Assignment allows teachers to post instruc-
tions and other messages to their students in a file they
can view at any time but which only the teacher can modify
or delete.  The document is the first thing students see
when they log into the class, and it can be modified as
often as the teacher wants.

Document
Management

Document Management organizes the system
for sharing documents in the class.  Students can turn in
drafts for peer review or collaboration and read the papers
and drafts of others in their class using the Turn In a
Document, the View a Document, and the Copy a Docu-
ment commands.

Login

Login  is student-based, allowing each student to log in
without complex administrative set-up.  With this login, the
student becomes a registered participant in all modules 
from Mail to InterChange to Document Management, all
work the student does is linked to a specific login name.

PromptManager

PromptManager is a SuperCard stack teachers
can use to create an Invent or Respond prompt series or
to customize an existing series.  Teachers can run the pro-
gram within DIWE or they can copy the files to a diskette
and work outside the DIWE classroom  on their office or
home computer.
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Local Area Network Tools
All the sharing and collaborating in DIWE takes place on a network, connecting
all the students in a particular class or lab at your site.

Local Area
Networking

Local Area Networking allows users to share
their files and documents.  DIWE requires a Local Area
Network set-up, with a fileserver and workstations.  Even if
you set up your site using a peer-to-peer network, one of
your machines will need to function as the fileserver by
serving as the location for the network files for the software
(including files such as the questions for Invent and Re-
spond and the shared files for Mail and InterChange ses-
sions).
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Chapter

3

Program Documentation
DIWE's program documentation includes three printable guides and three on-line
documentation files.  Only the Installation Guide is printed and distributed with
software diskettes.  The remaining guides can be printed using Microsoft Word
6.0, 7.0, Word 97, Microsoft Office or any other word processor which supports
Rich Text Format (RTF).

Teachers and students at your site will need access to these files.  The basic
questions which teachers and students need to use DIWE are answered in these
guides.  By providing copies of the files where teachers and students can reach
them, you'll enable users at your site to answer many of their own questions.
Details on providing additional access to the online help files is included in this
section.  Complete details on setting up and printing these files are available in
the Printing Program Documentation section of this guide.

User's, Instructor's, and Administrator's Guides

DIWE's print documentation includes three guides:  a User's Guide which de-
scribes the tools and commands in the program, an Instructor's Guide which ex-
plains how teachers can use the tools in the program, and an Administrator's
Guide which explains more about setting up and managing your site.  All three of
these guides are available on the Documentation diskette which accompanies
the installation diskettes.  These files are also available for download from
http://www.daedalus.com/tech/docs.html

On-Line Help System

DIWE's on-line help system answers questions about how to use the tools in the
program, how teachers can use the program to reach their pedagogical goals,
and what the administrator at your site will need to do to manage the system.  

There are two primary on-line help files which come with the program:  User Help
and Instructor Help.  The Program Help file explains how the tools in DIWE work.
Choose User Help to find information such as how to send a message in Mail,
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where InterChange transcripts are stored, and how to save a document so that
you can open it with another word processor.

The Instructor Help file explains commands available to the teacher and the ad-
ministrator and includes teaching strategies and resources for teaching with
DIWE. Use Instructor Help to find information such as how to make an Inter-
Change transcript and what strategies are effective for managing discussion.

A third help file, Character Help, provides basic details on using non-English
characters and special symbols in DIWE (e.g., how to type the letter c with a ce-
dilla – ç – in InterChange or Write).

To access these help files once you've logged into the program:

• Choose the User Help command from the Help pull-down menu.

• Choose Character Help command from the Help menu to access the Char-
acter Help file.

• Choose the Instructor Help  command from the Help pull-down menu to ac-
cess the Instructor Help file.  

Printing Specific Topics from the On-Line Help Files

All the topics in the on-line help files can be printed.  This capability comes in
handy when you need a handout which tells teachers or students how to com-
plete a task in DIWE.

To print a topic in either Help file, navigate to the topic you want to print, and
choose the Print Topic... command under the File menu.  

Running On-Line Help Files Outside DIWE

DIWE's On-Line Help files use the Windows operating system's help engines
(winhlp.exe and winhlp32.exe).  These on-line help files should be installed with
your Windows operating system.  If they're missing, you can install them using
your Windows Operating System installation disks or CD.  These help files will run
on any machine which has the Windows help engines installed and includes the
location of these engines in the path statement.

To launch one of the on-line help files outside DIWE:

1. Use File Manager or Windows Explorer to navigate to a DIWE5 directory at
your site.

2. Within the DIWE5 Folder, double-click on the Help Folder.

3. Within the Help Folder, you'll find help.hlp, charhlp.hlp and
teach.hlp.

4. Double-click on the file which you want to read, and the file should open.  

Copying DIWE's On-Line Help Files

Additionally, you can copy these files to a floppy diskette  or to another machine
to explore them when you are not in the Daedalus classroom – copy all the files
in the Help Folder to set up a copy of the help files outside your classroom.
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Making copies of the help files available for teachers outside the classroom can
be useful for teachers who want to learn more about the program but who have
limited access to the server or classroom.  

NOTE: Licensing for DIWE's On-Line Help Files
Teachers using DIWE can make a copy of these on-line help files for educa-
tional use on an office or home computer without violating the licensing agree-
ment.  

Accessing Other  Resources

Additional technical and pedagogical information is available from the Daedalus
Group WWW pages at http://www.daedalus.com/ and by e-mail to
help@daedalus.com.
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Installation and Setup

Chapter 4 Installing DIWE

Chapter 5 Checking DIWE's File Structure

Chapter 6 Setting Network Permissions

Chapter 7 Printing & Distributing Documentation

Chapter 8 Setting Up Your Site

Chapters 4 through 8 provide details on process the administrator should follow
to install DIWE at a site, to set-up instructors and classes, and to set preferences
and other settings.  

If you have already installed the software, following the instructions in the small,
printed Installation Guide which is distributed with the program diskettes, you're
ready to move directly to Chapter 8 to set up teachers and classes for your site.  

If you're installing the software, using the instructions in this Administrator's
Guide, begin with Chapter 4 and work through the Guide to Chapter 6 to install
DIWE at your school; then, move to Chapters 7 through 8 to set-up and custom-
ize your site.
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Chapter

4

Installing DIWE
The Daedalus Integrated Writing Environment (DIWE) is designed for use on a
local area network (LAN) running a network operating system such as Windows
NT or Novell.  Installation on the hard drive of the network fileserver proves quite
easy.  This manual assumes you have a working knowledge of your network op-
erating software, but if you do not, you'll need to consult the manuals and guides
for your network operating system to learn the exact steps you'll follow to set up
your network permissions and access properly.  

DIWE takes care of much of the maintenance of files, folders, and access rights;
you will, however, need to make some adjustments using the Administration utili-
ties of your network operating system before students may use the software.  As
with any software, you should make backup copies of your DIWE diskettes before
installation.  

DIWE and all its related files are compressed into an installation archive, seg-
mented onto six diskettes.  There are six basic steps to installing for your site:

• Confirming system requirements for your site (see below)

• Deciding on system setup (see page 15)

• Installing the software (see page 18)

• Setting up your workstations (see page 21)

• Checking file structure (see page 29)

• Setting network permissions (see page 35)

Confirming System Requirements

To use the Daedalus Integrated Writing Environment, your site needs
equipment which meets the following minimum specifications.  Using
computers or software which do not meet  these minimum specifications
could result in unsatisfactory performance.

Step

One
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   Individual Computers   

Minimum 386DX running at 33 MHz or higher (486 recommended)
Running Windows 3.1 or higher, Windows NT 3.51 or higher, or

Windows 95
DOS 6.2 or higher
6 MB of Free RAM available for the program (beyond other sys-

tem requirements and the needs for other software running).
Most machines need at least 24 to 28 MB of RAM; the spe-
cific requirements for your machines will depend upon your
hardware, disk space, and they software which is used at your
site.

10 MB free on hard disk
Operating at 640 by 480 screen resolution
Network hardware (TCP/IP compatible) and connections

NOTE: 32-bit Operating System Required
Windows DIWE requires a 32-bit operating system, either Windows 95,
Windows NT 3.51 or higher, or Windows 3.1 running with Win32s.  Your
workstations must run a 32-bit program even if you run the program
from the fileserver.

    Network        Server        Computer   

A dedicated network file server meeting the following minimum require-
ments:

Minimum 486DX running at 66MHz or higher:
16 MB of RAM
Recommended: 2 MB of free hard disk space per user per semester

[or 4 MB per year]
Network hardware (TCP/IP compatible) and connections

    Network-operating systems   

For 10 or more users to be connected at one time

Novell Netware®2.x or higher, or Windows NT™  3.5 or higher

NOTE: Running DIWE 5.3 on an NT Fileserver
While Windows NT 3.5 will work well for network management of
your DIWE files, you will not be able to use your network server as
a workstation for a student or teacher if you use this version of
Windows NT.  The DIWE application requires Windows NT 3.51.  

For fewer than 10 users to be connected at one time:

Windows for Workgroups® 3.1, Windows95®, or Lantastic.  Peer-to-
peer networks may support 10 or more users, but speed and per-
formance may be adversely affected.  Each network system has its
own individual characteristics which may limit performance as the
number of users connected and the amount of network activity in-
creases.
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Deciding on System Setup

Before you install DIWE to your workstations and fileserver, you need to make
some basic decisions and take some precautions to insure that the process of
setting up your workstations and fileserver goes smoothly.  Consider the following
questions:

1. Who Do You Need to Coordinate With At Your Site?  If you're in charge of
the machines you'll be installing DIWE on, you may not need to coordinate
the installation with anyone.  If not,   it's        always        best       to       check        with       the       technical
   support       staff        at       your       school   before changing anything on the network or in-
stalling new software.

• Since DIWE is a program which requires a network operating
system, you may need to coordinate with a network adminis-
trator to get permissions for the program's directories and files
set properly.  Further, a member of the network or technical
support staff at your school may have helpful advice about
setting up your classroom for the best possible network speed
and performance.

 
• Also, if you're installing the files in a computer classroom, be

sure to coordinate the installation with the teachers who will
be using the classroom — so that classes are not interrupted
and so that they will be aware that you are making changes
on the machines and server they use.

2. Which Installation Is Best for Your Site?  Determine whether you will install
the software only to the fileserver (and run a single network copy on all ma-
chines), or  install local files to your workstations with network files on the file-
server.  Many schools copy the program and its support files to each of the
individual workstations in the computer classroom to improve speed and
memory performance.  Installing copies of the program files on your worksta-
tions is preferred since this method accelerates the program's performance.

3. Exactly Where Will You Put DIWE's Files?  Determine the drive letters and
the paths for the location where the software will be installed.  Specifically,
you need to know the drive letter for the server as the machines on the net-
work will see it when they log in, and the exact path if you will be installing the
program  and its files within a subdirectory on the server.

During installation, the drive letters and path names for your
site will be written in these three distinct places:

•    In       the       WINDIWE.INI             file    .  The installation writes
the network path you choose to the configuration
file which DIWE 5.3 uses to enable login.  In order
for the program to function properly, the network
path must be entered correctly in this file.

•     On       the        Program       Icon        or        Shortcut   .  The installation
creates a program icon or shortcut for DIWE 5.3,
which the user can double-click to run from the
Program Manager or the Desktop in the future.  

•    In       the        Program's        UnInstaller   .  The installation cre-
ates a second program icon or shortcut, UnInstall

Step

Two
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DIWE.  Double-clicking on this icon removes the
DIWE5 directory and program, along with the pro-
gram group, shortcut and/or icons.  It also erases
itself.  It does not remove system resources, and it
does not touch network installations.   

This can be a very handy utility as you experiment with
your installation options, but you may want to remove the
UnInstall capacity so that your students do not delete
their programs.

NOTE:  Choosing a Directory Path on Windows 3.1
   If       you're        using         Windows        3.1        or         Windows       for         Workgroups
    3.11,       the        path       you       choose       can      include        no         more       t       han        6
   characters        plus       the        drive      letter.     These Windows operat-
ing systems have a limit of 64 characters for the name of
any directory which is created. Because Windows DIWE
requires complex directory structures for the network files,
the remaining 57 characters are required for the paths
which will be created.  

If you install the network components to the root of your
server, everything should work.  If you cannot install to
the root, you can use the Connect Network Drive button
in File Manager to mount a longer directory path using a
drive letter.  Consult your WINDOWS documentation for
more information.

4. Do You Have Any Other Copies of DIWE On Your Server or Workstations?
You need to check the directory names for any other copies of DIWE on your
machines to ensure that none of your existing files are overwritten.  

   If you also have a copy of DOS DIWE    
If you have copies of DOS DIWE on your server or worksta-
tions, check the names of the directories and the executable
files to ensure that they will not conflict with the directory
names for the Windows version of the program  (DIWE5 and
DIWE5NET).  You should not have any conflicts if you have
copies of both the DOS and the Windows versions on your
server and workstations as long as the names are different.
The default directory name for DOS DIWE will not conflict with
the default for Windows DIWE.  

   If you also have a copy of MACINTOSH DIWE    
If you have copies of MAC DIWE on your Novell or NT server,
check the names of the directories to ensure that that will not
conflict with the directory names for the Windows version of
the program (DIWE5 and DIWE5NET).  You should not have
any conflicts if you have copies of both the MAC and the
Windows versions on your server and workstations as long as
the names are different.  The default directory name for MAC
DIWE will not conflict with the default for Windows DIWE.
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   If you already have a copy of WINDOWS DIWE    
If you have a previous copy of WINDOWS DIWE on your
server or workstations, you should rename, move, or delete
the existing DIWE5 and  DIWE5NET directories on your file-
server and workstations to avoid conflicts, corrupt files, and
other difficulties.   You will need to replace all the program
components  and the local area network  components.  In-
structors might want to archive material students generated in
their classes. If so, this should be done before you install
DIWE 5.3 so you should check with those instructors who
have been using the copy of the program you have installed
before removing it from the server.  After the files are deleted
or renamed, use the installation diskettes to install a fresh set
of the Local Area Network files, following the instructions in
this guide.

5. Are your workstations running a 32-bit operating system?     DIWE
requires a 32-bit operating system.  Even if you're running a
single copy of the program which is located on the server, the
workstations must have a 32-bit operating system for the
software to load and run.  

If you're running Windows 95 or Windows NT 3.51 or higher
on your workstations, your workstations are running a 32-bit
operating system and you will not need to install any addi-
tional system resources.

If you're running Windows 3.1 or Windows for Workgroups
3.11, you need to check your machines to determine whether
they are running a 32-bit operating system.  As they are origi-
nally installed, Windows 3.1 and Windows for Workgroups
3.11 are 16-bit operating systems.  By installing a set of addi-
tional system resources, however, you can upgrade these 16-
bit operating systems to 32-bit operating system.  

If you're not sure whether your workstations are running a 32-
bit operating system, follow these steps to find out:

• Navigate to your \Windows\System directory and look
for a file named  WIN32S.INI.   I f  you do not have a
WIN32S.INI file, your machine is not running a 32-bit op-
erating system, and you need to install additional system
resources.

• If you have the WIN32S.INI file, open it using a text edi-
tor, and check the information for Version in that file.  If
the version listed is not 1.30, you need to update your
system resources.

If you determine that you need these additional system re-
sources, you'll need to install Win32s, a subsystem created by
Microsoft, when the installation routine asks you if you want to
install these system files.
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Installing the Software

These instructions explain how to install the program's local area network files
and program files to your fileserver.  When you finish  you will have installed the
WIN32S system resources if they are necessary for the workstation, and you'll
have installed a copy of the DIWE5 directory, which contains the program files,
and a copy of the DIWE5NET directory, which contains the local area network
files.  

To set up DIWE 5.3 at your site, you will install the software from a workstation
which is attached to the fileserver.  There is less to go wrong when you work from
a workstation which is already logged on to the fileserver so that you can verify
the actual paths that the workstations will see when they are running DIWE.  In-
stalling directly on the fileserver is not recommended.

NOTE:  Stand-Alone Installation
Follow these instructions when you install the program to a single-
machine in order to run the program in a Stand-Alone configuration.
Even though you are not working on a network, you will need to install
both the Program Components and the Local Area Network Compo-
nents (see Step 6) to run the program.  When you choose locations for
these files, you will choose a location on the stand-alone machine
(rather than navigating to another machine in Steps 7 and 8).

1. Log on to the network server with full permissions.

Make sure that the workstation you install the software from is logged on to
the server with full read/write/create/delete rights to the drives on which you
are installing the software.  Installation will fail if these rights are not in place.
(See the "Setting Network Permissions" section on page 35 for information
on the specific permissions required for your network.  Check with your net-
work administrator if you're unsure how to set network permissions.)

2. Depending on your operating system, there are four ways to install DIWE:
from the Program Manager, from the File Manager, from the Windows Ex-
plorer, and from the Windows 95 or NT4  Start Menu.  They all involve run-
ning SETUP.EXE from Diskette 1.  

Using the Start Menu in Windows 95/NT 4 or the Program Manager in other
versions of Windows:

a. Put Diskette 1 in your diskette drive.

b. From the Start Menu in Windows 95 or from the File menu in
other versions of Windows, choose the Run.… Command.

c. Type A:\setup (assuming A is the Diskette Drive).
If you don't know the letter for your diskette drive, click the
Browse button, use the standard file dialog box to find the
diskette drive, and select SETUP.EXE.

Using the File Manager or Windows Explorer:

a. Put Diskette 1 in the diskette drive

Step

Three
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b. Choose the A: Drive (assuming A is the Diskette Drive).
If you don't know the letter for your diskette drive, click the
Browse button, use the standard file dialog box to find the
diskette drive, and select SETUP.EXE.

c. In this window, double-click SETUP.EXE

3. Once you've chosen SETUP.EXE, wait a few moments while the InstallShield
Wizard begins loading files into memory and checking your system resources
to prepare for installing the software.

4. When the InstallShield Wizard finishes preparing, follow the instructions on
screen to begin your installation.  First, you will need to confirm that you want
to install.  Click the Next button to install DIWE 5.3; click the Cancel button to
exit and make no changes to your machine.

NOTE:  Using the Installation Diskettes
You may  not need to use all the installation diskettes, and you may
need to reinsert some diskettes.  Follow the prompts which appear on
screen. Specifically, if you're installing the software in  Windows 95 or
Windows NT or if you do not install the Win32s resources, you will not
use Diskette 2.  If you install the Win32s resources, the installer will ask
you to reinsert Diskette 3.

5. If your machine is running Windows 3.1 or Windows for Workgroups 3.11, the
installer will ask if you want to install Win32s.  If your machine is using Win-
dow NT or Windows 95, go on to step 6.

If you're unsure whether you need to install these system resources, quit the
installer for Windows DIWE and complete the instructions on determining
whether your machines are using a 32-bit operating system on page 17 to
find out whether you need these files.  

• If you need to install Win32s, choose the Yes button, and
follow the instructions on screen to install these support files.
Insert additional diskettes as requested.

• If you do not need to install Win32s, choose the No button,
and move on to the next part of the installation.  The Installer
will give you a warning before proceeding, stating that "You
may not be able to run DIWE 5.3 without WIN32S.
If you need to install it, run SETUP again." —
This message is normal. Click the OK button and proceed
with the installation if you're sure you do not need the
WIN32S files.

6. You'll see a splash screen, followed by information about the installation op-
tions for the program. This Setup program gives you the option of installing all
or part of DIWE 5.3.  Choose among the three options as appropriate for
your site.      Preferably,      leave       the       check        boxes        at       their        defaults        while      installing
   to       the       fileserver.   

• Program Components installs all the files you are required  to
run the program on a workstation (but does not install the
supporting network files).  
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• Local Area Network Components copies files to the fileserver.
These files are required to enable login, communication, and
document management.

•  Put Uninstaller with the Program copies an Uninstaller pro-
gram.  On workstations or other machines which students
use regularly, it's probably best NOT to install the Uninstaller
without taking special precautions to protect your files (so
that students will not accidentally erase the program from the
machines).

7. Choose the location for the Program Components  either by typing a path or
using the Browse  button to navigate to the desired location.  Program files
will be copied to a DIWE5  directory, which will be created at the location you
choose.  This directory will contain the DIWE program, its initialization file, dic-
tionary files, and help files.  The path you choose can be a network location
for the program components or a local workstation location (if you have de-
cided to copy the program to the workstations).

8. Next, choose the location for the Local Area Network Components either by
typing in a path or using the Browse  button to navigate to the desired loca-
tion.  Network files will be copied to a DIWE5NET directory which will be auto-
matically created at the location you choose.   This path should be the net-
work location on for the files, using the drive letter and path which the work-
station uses when it logs on the network.

NOTE:  Choosing a Network Destination

1.    If       you're        using         Windows        3.1        or         Windows       for         Workgroups        3.11,       the        path
   you       choose       can      include        no         more       than        6       characters        plus       the        drive      le       t-   
   ter.     These Windows operating systems have a limit of 64 characters
for the name of any directory which is created. Because Windows
DIWE requires complex directory structures for the network files, the
remaining 57 characters are required for the paths which will be cre-
ated.  If you install the network components to the root of your server,
everything should work.  If you cannot install to the root, you can use
the Connect Network Drive button in File Manager to mount a longer
directory path using a drive letter.  Consult your WINDOWS documen-
tation for more information.

2.      Windows        DIWE       requires        a        drive      letter       for       the        network        path    . Universal
Naming Convention names, based on the server's name, will cause
parts of the program to fail. Rather than choosing a network path like
\\ENGL, you need to choose the network drive like X:\.

9. Follow the instructions on screen to insert additional installation diskettes and
finish the installation.  (You may not need to use all diskettes.)

10. After  all the files are installed to your machine, you will be offered a chance
to look at a file called SYSINFO.DAT.  This file provides a portrait of your in-
stallation (your machine, the paths you have installed to, etc.).  Please read
this file and save it in a safe place; better yet, print this file.           If       you        need       to
     make        a       tec       h        nical       call,             you       can       fax       this       form       to        us,        or        attach       the       file       to        an        e-   
     mail         message       to        help       speed        up       the       troubleshooting        process.   

11. Once you've chosen the Finish button in the Installer, a Daedalus Program
Group containing an Icon for DIWE 5.3 and, if you installed it, an icon for
Uninstall DIWE 5.3 will open.  
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Setting Up Your Workstations

Many schools copy the program and its support files to each of the individual
workstations in the computer classroom to improve speed and memory perform-
ance.  Other schools use the copy of the program on the fileserver from all work-
stations.  

The instructions you follow in this section will depend upon how you choose to set
up your workstations:

• If you are installing all program files to the workstation (the pre-
ferred method), see the "Installing All Program Files" section be-
low.

• If you will run a single copy on the fileserver but need to install the
Win32S program resources on your workstations, see the
"Installing WIN32S System Resources Only" section on page 24.

• If you will run a single copy on the fileserver  but want to install
program icons on your workstations, see the "Creating Windows
3.1  and NT 3.51 Icons Only" section on page 25.

• If you will run a single copy on the fileserver  but want to install a
Windows 95 shortcut on your workstations, see the "Creating
Windows 95 or NT 4.1 Shortcut Only" section on page 26.

• If you will run a single copy on the fileserver  but want to add
DIWE 5.3 to the Windows 95 Start Menu on your workstations,
see the "Adding DIWE to the Windows 95 or NT 4.1 Start Menu"
section on page 26.

NOTE:  Installing Network Files
To avoid network problems and ensure that DIWE 5.3 works properly,
you need to install the Local Area Network files on your fileserver before
setting up your workstations.  The copy of the DIWE5NET directory
(containing the full program subdirectories such as CLASSES and
USERS) should exist on the file server ONLY.

Installing All Program Files

These instructions explain how to install all program files and system re-
sources to your workstation.  When you finish you will have installed
WIN32S system resources if they are necessary for the workstation and a
copy of the DIWE5 directory, which contains the DIWE program
(WINDIWE.EXE), its initialization file (WINDIWE.INI), a directory of Help files
(HELP), and a directory of dictionary tools (PROX).  This is the preferred in-
stallation method.

1. Log on to the workstation and the fileserver with full permissions.  (You will
not change the files on the fileserver, but the installer will ask you to locate
these files so that the workstation's configuration file can be set correctly).

Step

Four
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2. Depending on your operating system, there are four ways to install DIWE:
from the Program Manager, from the File Manager, from the Windows 95
Explorer, and from the Windows 95 Start Menu.  They all involve running
SETUP.EXE from Diskette 1.  

Using the Start Menu in Windows 95 or the Program Manager in other ver-
sions of Windows:

a. Put Diskette 1 in your diskette drive.

b. From the Start Menu in Windows 95 or from the File menu in
other versions of Windows, choose the Run.… Command.

c. Type A:\setup (assuming A is the Diskette Drive).
If you don't know the letter for your diskette drive, click the
Browse  button, use the standard file dialog box to find the
diskette drive, and select SETUP.EXE.

Using the File Manager or Windows 95 Explorer:

a. Put Diskette 1 in the diskette drive

b. Choose the A: Drive (assuming A is the Diskette Drive).
If you don't know the letter for your diskette drive, click
Browse , use the standard file dialog box to find the diskette
drive, and select SETUP.EXE.

c. In this window, double-click SETUP.EXE

3. Once you've chosen SETUP.EXE, wait a few moments while the InstallShield
Wizard begins loading files into memory and checking your system resources
to prepare for installing the software.

4. When the InstallShield Wizard finishes preparing, follow the instructions on
screen to begin your installation.  First, you will need to confirm that you want
to install.  Click the Next button to install DIWE 5.3; click the Cancel button to
exit and make no changes to your machine.

NOTE:  Using the Installation Diskettes
You will not need to use all the installation diskettes to install the Pro-
gram Components to your workstation, and you may need to reinsert
some diskettes.  Follow the prompts which appear on screen. Specifi-
cally, if you've installed the WIN32S resources, the installer will ask you
to reinsert Diskette 3, and you will not use Diskette 6. If you did not
need to install the WIN32S resources, you will skip both Diskette 2 and
Diskette 6.

5. If your machine is running Windows 3.1 or Windows for Workgroups 3.11, the
installer will ask if you want to install Win32s.  

If you're unsure whether you need to install these system resources, quit the
installer for Windows DIWE and complete the instructions on determining
whether your machines are using a 32-bit operating system on page 17 to
find out whether you need these files.

• If you need to install Win32s, choose the Yes button, and
follow the instructions on screen to install these support files.
Insert additional diskettes as requested.
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• If you do not need to install Win32s, choose the No button,
and move on to the next part of the installation.  The Installer
will give you a warning before proceeding, stating that "You
may not be able to run DIWE 5.3 without WIN32S.
If you need to install it, run SETUP again." —
This message is normal. Click the OK button and proceed
with the installation if you're sure you do not need the
WIN32S files.

6. You'll see a splash screen, followed by information about the in-
stallation options for the program. This Setup program gives you
the option of installing all or part of DIWE 5.3.  Two of the three
options will be checked.  Since you are installing only program
files, you will need to change this default.

The Program Components  option installs the files to your
workstation and should remain checked.

Uncheck the Local Area Network Components option —
you can have only one copy of the network files and that
copy should be on the fileserver.

Check the Put Uninstaller with the Program option if you
want to install this resource.  On workstations which stu-
dents use regularly, it's probably best not to install this file
without taking special precautions to protect your program
files.  The Uninstaller will not affect your network files, but
will remove the Program Components on the workstation.

7. Choose the location for the Program Components either by typ-
ing in a path or using the Browse  button to navigate to the de-
sired location.  These files will be copied to a DIWE5  directory at
the location you choose.

8. You'll be asked if a Network directory is installed.

Click the YES  button if you've set up your network fileserver,
and proceed with these instructions.

If you have not installed your network files, click the NO button
and  return to the section titled "Installing DIWE 5.3" on
page 13 and follow the instructions to install the local area
network files.  You must install the network files before the
workstation files to ensure that  that the program's con-
figuration file (WINDIWE.INI) is set properly.

9. Next, you'll be asked to locate the DIWE5NET directory on your
fileserver.  Either type the path to the DIWE5NET directory in the
PATH: field or navigate to the directory by clicking on the Drives:
and Directories: fields until the path to the DIWE5NET directory
appears in the PATH: field.  Once you've selected the path, click
OK.  The installation will begin immediately.

10. Follow the instructions on screen to insert additional installation
diskettes and finish the installation.  You will not use all the disk-
ettes in this process.
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11. Once you've chosen the Finish button in the Installer, a Daedalus
Program Group containing an Icon for DIWE 5.3 and, if installed,
for Uninstall DIWE5.3, will open.  

Installing WIN32S System Resources Only

These instructions explain how to install only the system resources to your
workstation.  When you finish, you will have installed WIN32S system re-
sources which are necessary to run DIWE 5.3 on a Windows 3.1 or Win-
dows for Workgroups 3.11 workstation.  If you're unsure whether you need
these resources, see the instructions on determining whether your ma-
chines are using a 32-bit operating system on page 17.

1. Log on to the workstation with full permissions.

2. There are two ways to install the WIN32S resources:  from the Program Man-
ager and from the File Manager.  Both methods involve running SETUP.EXE
from Diskette 1.  

Using the Program Manager:

a. Put Diskette 1 in your diskette drive.

b. From the File menu, choose the Run.… Command.

c. Type A:\setup (assuming A is the Diskette Drive).
If you don't know the letter for your diskette drive, click the
Browse button, use the standard file dialog box to find the
diskette drive, and select SETUP.EXE.

Using the File Manager:

a. Put Diskette 1 in the diskette drive.

b. Choose the A: Drive (assuming A is the Diskette Drive).
If you don't know the letter for your diskette drive, click the
Browse  button, use the standard file dialog box to find the
diskette drive, and select SETUP.EXE.

c. In this window, double-click SETUP.EXE

3. Once you've chosen SETUP.EXE, wait a few moments while the InstallShield
Wizard begins loading files into memory and checking your system resources
to prepare for installing the software.

4. When the InstallShield Wizard finishes preparing, follow the instructions on
screen to begin your installation.  First, you will need to confirm that you want
to install.  Click the Next button to install DIWE 5.3; click the Cancel button to
exit and make no changes to your machine.

5. The installer will ask if you want to install Win32s.  Choose the Yes button,
and follow the instructions on screen to install these support files.  Insert addi-
tional diskettes as requested.

NOTE:  Using the Installation Diskettes
You will not need to use all the installation diskettes to the WIN32S sys-
tem resources to your workstation.  Follow the prompts which appear on
screen. You will not use Installation Diskette 4, 5, or 6.
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6. Once the WIN32S resources have been installed, you'll see a splash screen,
followed by information about the installation options for the program.  Since
you have chosen to install only the WIN32S system resources, you are fin-
ished at this point.  Choose the Cancel button to quit the installer.

7. The Installer will ask you to confirm that you want to exit the DIWE Setup rou-
tine.  The dialog box which appears states, "Setup is not complete.  If you
exit the Setup program now, the program will not be installed."  Since you do
not want to install the program, only the WIN32S resources, choose the Exit
Setup button in the dialog to quit the Setup program.

Creating Windows 3.1  and NT 3.51 Icons Only

These instructions explain how to create a program group and a program
icon for DIWE on your workstation, without installing the program files.
When you finish, you will have created a program group for your Daedalus
software (optional), and you will have created a program icon for the DIWE
5.3 program which provides a shortcut to the single copy of the program
which you have installed on your fileserver.

1. Double-click the icon for the program group where you want to place the icon
for DIWE.  For example, if you want to place the DIWE 5.3 icon in the Appli-
cations program group, double-click that group.  If you want DIWE 5.3 to
have its own Program Group (in addition to the program icon) follow these
steps to create a new Program Group:

a. Under the File menu, choose the New command.
b. In the dialogue box that appears, choose Program Group and

click the OK button.
c. In the Program Group Properties Dialogue box which appears,

type the name of the group in the field below Description
(this is the name that will appear beneath the program group
icon).

d.  Click the OK button, and the group will be created and
opened.  It should be your active program group.

2. With the program group you've chosen or created active, under the FILE
menu, choose the New command.

3. In the dialogue box that appears,  choose Program Item and click the OK
button.

4. In the Program Items Properties dialog box that appears, you enter the fol-
lowing information, replacing the example drive letter X: with the letter for
your server and adding any additional directories in the path to the
WINDIWE.EXE program or batch file (you can use the Browse  button to navi-
gate to the file as well):

Description:    DIWE 5.3 for Windows
(this is the name that appears under the icon)

Command Line:   X:\DIWE5\WINDIWE.EXE
(this is the command to start the program)

Working Directory:   X:\
(the directory WINDIWE is in)

Shortcut Key:   None
(you can enter a shortcut — look at help in the Program Items Properties
dialogue box for more information.)
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5. Click the OK button.  The Program Item you've just created should show up
in the Program Group window.  You should be able to double-click the Maze
icon and start the program from your workstation.

Creating Windows 95 or NT 4.1 Shortcut Only

These instructions explain how to create a Windows 95 shortcut for DIWE
on your workstation, without installing the program files.  When you finish,
you will have created a shortcut for your Daedalus software which points to
the single copy of the program which you have installed on your fileserver.

1. With the desktop as your active application, click the right mouse button, and
choose the New command.

2. From the New pop-up menu, choose the Shortcut command.

3. Use the Create Shortcut Wizard to set up your shortcut.  Click the Browse
button and navigate to the location of the DIWE5 directory.  

a. Use the Look In drop-down menu at the top of the dialog box
to move to the Network Neighborhood and connect to the
server where your network copy of DIWE 5.3 is located.

b. Navigate to the exact location of the WINDIWE.EXE file by
double-clicking on the directory folders in the middle of the
dialog box.

c. Choose the Open button once you've navigated to the
WINDIWE.EXE file on your fileserver.

4. Once the path to the WINDIWE.EXE file on your fileserver appears in the
Command Line box in the Create Shortcut Wizard, choose the Next button at
the bottom of the window.

5. Type a name for your Windows DIWE shortcut in the next box — this is the
name which will appear beneath the icon on your desktop.

6. Choose the Finish button at the bottom of the dialog box.  A  new shortcut
with an aqua-colored maze icon will appear on your desktop.

NOTE:  Creating a Windows 95 Shortcut in A File or Folder
If you want to create a shortcut which will appear in a file folder or an-
other location in Windows 95, you can open the file folder or location
you've chosen for the shortcut and follow these same instructions.  The
shortcut will appear in the location where you begin this process —
whether a file folder, the desktop, or some other location.  Check your
Windows 95 On-Line Help for more information.

Adding DIWE to the Windows 95 or NT 4.1 Start Menu

These instructions explain how to add DIWE to the Windows 95 Start
Menu on your workstation, without installing the program files.  When you
finish, you will have created a shortcut in your Start Menu for your
Daedalus software which points  to the single copy of the program which
you have installed on your fileserver.

1. From the Windows 95 Start Menu, choose the Settings... Command.  

2. From the Settings... sub-menu, choose the Taskbar Command.
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3. In the Taskbar Properties dialog which appears, choose the Start Menu Pro-
grams  Tab.

4. In the Customize Start Menu area of the dialog, choose the Add button.

5. Type the location of the copy of DIWE 5.3 on your fileserver in the Command
Line box, or follow these instructions to navigate to the program:

a. Click on the Browse  button.

b. Use the Look In drop-down menu at the top of the dialog box
to move to the Network Neighborhood and connect to the
server where your network copy of DIWE 5.3 is located.

c. Navigate to the exact location of the WINDIWE.EXE file by
double-clicking on the directory folders in the middle of the
dialog box.

d. Choose the Open button once you've navigated to the
WINDIWE.EXE file on your fileserver.

6. Once the path to the WINDIWE.EXE file on your fileserver appears in the
Command Line box, choose the Next button at the bottom of the window.

7. Select a location for the DIWE 5.3 shortcut on the Start Menu by double-
clicking on the folders listed or by choosing the New Folder... button and
naming your newly created file folder.

8. Once the file folder on the Start Menu where you want DIWE 5.3 to appear is
open and highlighted, choose the Next button.

9. Type the name for DIWE which you want to appear in the Start Menu in the
next box which appears on screen.

10. Choose the Finish button at the bottom of the dialog box.

11. Choose the OK button to close the Taskbar Properties dialog.  The new item
should appear in your Start Menu in the location you chose, along with an
aqua-colored maze icon.
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Chapter

5

Checking File Structure

Before you launch the software, check the files and directories which have been
installed on your machines to make sure that all the program files are in place.
Use the Windows 95 Explorer or FileManager in other versions of Windows to
navigate through these directories.  Alternately, you could work in DOS using the
DIR command.

Check the directories for the files and subdirectories listed.  Immediately after you
install, however, you should see the files and subdirectories listed.  If you check
the file structure after you've begun using DIWE at your site, you'll see additional
files as noted.

If you find that files are missing when you check the structure, the best solution
would be to delete the incomplete copy or DIWE5 or DIWE5NET and reinstall.  If
classes are already using the software, however, reinstalling probably isn't an op-
tion.  Instead, you should copy any missing files from your most recent backup.

Checking the DIWE5NET Directory

The DIWE5NET directory is the network directory which should exist only on your
fileserver.  This directory contains the network files which are used for login and
the directories where the messages and documents for each class are stored.

In the DIWE5NET directory, you should find the following subdirectories and files.
As the program is used at your site, additional subdirectories and files will be
added; however, those listed are the minimal files and subdirectories needed to
run the program.  In other words, you may find more files and subdirectories than
those listed here, but if you find fewer, something may be wrong.

Concord.ini Subdirectory

The Concord.ini file is a customizable list used by the Concordance, which is
available from the Write  menu.

Bitmaps Subdirectory

The Bitmaps Subdirectory holds several bitmap files which can be selected when
a writer chooses the Insert Bitmap... command in the Write word processor.  You
should see the following:
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2 blk_bull.bmp Black Bullet
2 smblklin.bmp Thin Black Line
2 blk_line.bmp Thick Black Line
2 3blkline.bmp Triple Black Line

Classes Subdirectory

The Classes Subdirectory holds class files for each class created at your site.
When the program is first installed, you'll see a subdirectory containing only the
files for the default class, which is taught by The Administrator.  You should see
the following:

1 TADMIN01 Subdirectory which contains four subdirectories and a single
file:

1 ASSIGN Subdirectory Which contains the file
announce.pgf, the current Class
Assignment

1 CHAT Subdirectory Which contains the MAIN
subdirectory.  This directory is used
for current InterChange sessions.

1 MAIL Subdirectory Which contains the MAIN
subdirectory.  This directory is used
for current Mail sessions.

1 DOCS Subdirectory Which contains the TADMINIS.000
subdirectory

2 tadmin00.ini File The file which records class-
specific preferences

Once you've set up classes at your site and these classes have begun meeting,
this directory will contain a subdirectory parallel to the TADMIN00 subdirectory for
each class setup at your site.  See the explanation of the naming convention for
these subdirectories on page 37.

Invent Subdirectory

The Invent Subdirectory contains twelve Invent prompt files which are used in
the question and explanation sections of DIWE's Invent module.  You should see
the following:

2 explore1.inv
2 explore2.inv Prompts for Exploratory Papers
2 explore3.inv

2 express1.inv
2 express2.inv Prompts for Expressive Papers
2 express3.inv
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2 inform1.inv
2 inform2.inv Prompts for Informative Papers
2 inform3.inv

2 persuad1.inv
2 persuad2.inv Prompts for Persuasive Papers
2 persuad3.inv

Respond Subdirectory

The Respond Subdirectory contains two Respond prompt files which are used in
the question and explanation sections of DIWE's Respond module.  You should
see the following:

2 global.rev Prompts for Global Revision

2 local.rev Prompts for Local Revision

PM Subdirectory

The PM Subdirectory contains five files which teachers at your site can use to write
customized prompts for DIWE's Invent and Respond modules.  You should see
the following:

2 pmanager.exe The PromptManager Program

2 pmanager.txt Read-Me File with program
documentation

1 HELP Subdirectory Which contains the PM.HLP file

2 commdlg.dll
2 vbrun300.dll Three program support files
2 cmdialog.vbx

Records Subdirectory

The Records Subdirectory contains three files which are used for login and regis-
tration.  You should see the following:

2 allusers.dat A list of users
2 allclass.dat A list of classes
2 regtable.dat The registration table

Once you've set up classes at your site and students begin logging in to the
program, additional files will appear in this directory.  It is normal to see the
following nine files once the program has been used.

2 allusers.dat
2 allusers.lok Users lists
2 allusers.bak

2 allclass.loc
2 allclass.bak Classes lists
2 allclass.dat
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2 loktable.dat
2 regtable.dat Registration tables
2 regtable.bak

Users Subdirectory

The Users Subdirectory contains a private subdirectory for each person who has
logged in at your site.  When the program is first installed, you'll see only one
subdirectory for the default user, The Administrator.    You should see the follow-
ing:

1 The TADMINIS.000 subdirectory, which should be empty (or could con-
tain temp.tmp)

Once you've set up classes at your site and students begin logging in to the pro-
gram, this directory will contain a subdirectory parallel to the TADMINIS.000 sub-
directory for each user at your site.  See additional details on how this subdirec-
tory is used in the "Users Subdirectory" section on page 32.

Checking the DIWE5 Directory

The DIWE5 directory is the program files directory which can exist on every work-
station, but may only exist on your fileserver — it depends upon how you've cho-
sen to se up your site.  This directory contains the program and the local support
files which are used for on-line help and the dictionary.

In the DIWE5 directory, you should find the following subdirectories and files.  As
the program is used at your site, no additional subdirectories will be added.
Those listed are the minimal files and subdirectories needed to run the program.
In other words, if you find fewer, something may be wrong.

Prox Subdirectory

The Prox Subdirectory contains seven files used by the dictionary, thesaurus,
and spell check tools in the program.  You should see the following:

2 eng.env
2 eng.hyp
2 eng32.clx
2 engphon.env
2 usa37.lex
2 usa90.dct
2 usa91.ths

Help Subdirectory

The Help Subdirectory contains two files used for on-line help in the program.
You should see the following:

2 charhlp.hlp Character Help file, for accented
letters and special characters

2 help.hlp Program Help file
2 teach.hlp Teacher Help file



Windows DIWE 5.3 Administrator's Guide33

1 extras subdirectory Location where additional teacher
resources will be installed (these
resources are sold separately)

1 handbooks subdirectory Location where additional teacher
resources will be installed (these
resources are sold separately)

If you've run the on-line help files, you may also see indexing files created by
Windows when the Help files were used.  The specific files you see will de-
pend upon the version of Windows you use.  You're likely to see additional
files such as help.gid or help.fts.  These are normal files.

Plus Two Files

Additionally the DIWE5 directory contains three files.  You should see the follow-
ing:

2 windiwe.exe the program itself
2 windiwe.ini the program's required initialization

file
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Chapter

6

Setting Permissions
Once DIWE is installed, you'll need to set the network permissions
for the files and directories.  DIWE 5.3 is based on a text-sharing
pedagogy which assumes that students and instructors will be cre-
ating documents and messages on a network server's hard disk.  In
order to create and modify files on the network, the program must
have network access rights to the directories containing the
Daedalus software.

Assigning Permissions to DIWE5NET
In general, the program needs full network permissions to the DIWE5NET
directory and all its subdirectories on the server.  Specific permissions and the
way they are set vary depending on the network software you're using.  To
ensure the software functions properly, you'll need to set  the  following net-
work permissions:   

Novell Netware 2.x Read, Write, Create, Open, Search,
Modify, Delete, Parental

Novell Netware 3.1 or 4.x Read, Write, Create, Erase, Modify,
File Scan

Windows NT 3.5 or higher Read, Write, Execute, Delete

Windows for Workgroups Full Access
(Create, Change, Delete, Rename,
Move, or Read Files, and Run Appli-
cations)

Windows 95 Full Access Type

Lantastic Read Access, Write Access, Create
a File, Make Directory, File Lookup,
Delete Files, Delete Directories, Re-
name Files, Execute Program
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Please note that the software has not been specifically designed to work with
restricted privileges, and unpredictable problems and failures may arise if a
system administrator chooses not to follow the standard requirement of full
access to all directories.

Assigning Permissions to DIWE5
The DIWE5 directory contains two subdirectories (Help and Prox) and three
files (Launcher, Windiwe.exe, Windiwe.ini).  The simplest way to as-
sign permissions to these resources is to assign all users full permissions to
the DIWE5 Directory, following the guidelines for your network operating sys-
tem in the proceeding section on permissions for the DIWE5NET directory.

You can, however, set more restrictive permissions to protect these files and
directories, following the guidelines in this table.

Directory or File Description Recommended Per-
missions

\HELP On-Line help files Read-Only for Adminis-
trators, Teachers, and
Students

\PROX Language files used for the
Spell Check, Dictionary, and
Thesaurus.

Read-Only for Adminis-
trators, Teachers, and
Students

Windiwe.exe The program itself Read and Execute Pro-
gram for Administrators,
Teachers, and Students

Windiwe.ini The program's initialization
file

Read-Only for Students
Read and Write for
Administrators and
Teachers

Setting More Restrictive Permissions

Teachers and the Administrator need full access privileges to the DIWE5NET di-
rectory which are outlined in the "Assigning Permissions to the DIWE5NET Direc-
tory" section on page 35.  However, if your network differentiates between stu-
dent logins to the fileserver and teacher or administrator logins to the fileserver,
you can set more restrictive permissions to some of the files and directories on
the file server.

Once you've set up your classes, you can use these instructions to increase the
permissions for some of the files in your DIWE5NET directory on the fileserver.

1. Set up all the classes at your site following the instructions in the "Adding
New Classes" section on page 44.  This process will create some of the files
you need to set permissions for.  

You must setup classes before you can assign these additional permis-
sions to their subdirectories.

2. Once you've created all the classes at your site, navigate through the directo-
ries for each class you've created, setting permissions according to the table
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below.  "Full" permissions include all permissions listed for your network oper-
ating system on page 35 in the preceding "Assigning Permissions to the
DIWE5NET Directory" section.

Directory Teacher
Permissions

Student
Permissions

\Classes\<teacher>\Assign Full Read-Only

\Classes\<teacher>\Docs\Assign Full Read-Only

\Classes\<teacher>\Docs\Chat Full Read-Only

\Classes\<teacher>\Docs\Mail Full Read-Only

\Invent Full Read-Only

\PM Full No Access

\Respond Full Read-Only

Note that some of these directories will not exist until the teachers and stu-
dents have logged in.

File Structure for Each Teacher at Your Site

On the fileserver, you'll find a DIWE5NET\Classes directory.  In this directory,
you'll find a subdirectory for each class which has been created at your site —
To set these additional permissions, navigate to folders in each of the subdi-
rectories created for these classes to restrict the permissions.  In the table
above, these class subdirectories are indicated in the path by the
"<teacher>" directory.

A <teacher> subdirectory will exist for each class which has been created at
your site.  You'll need to navigate to the subdirectories created for each
teacher at your site in order to restrict permissions fully.

The names for these subdirectories are based on the name of the teacher for
the class.  For instance, if you set up a class for Donna Godchaux, the subdi-
rectory would be named something like DGODCH03 — using the first letter of
the teacher's first name, the first five letters of the teacher's last name, and a
two-digit number based when the class was created.  The "03" here indicates
that this was the third class created at the site.  

Adding Restrictions for Invent and Respond
The Invent and Respond directories in the DIWE5NET directory on the file-
server contain fourteen basic prompt files — ten Invent files (*.INV) and two
Respond (*.REV) files.  Additionally, teachers will place any customized
prompts which they write for the program in these directories so that the
questions will be available to students in the program.  You can set additional
access rights for these directories and files to help protect the files.
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Setting Permissions for the Files in the Invent and Respond Directories

To ensure that the files are not accidentally erased or overwritten, restrict ac-
cess to the following files to Read-Only for all users at your site:

In the \DIWE5NET\Invent directory:

explore1.inv inform1.inv
explore2.inv inform2.inv
explore3.inv inform3.inv
express1.inv persuad1.inv
express2.inv persuad2.inv
express3.inv persuad3.inv

In the \DIWE5NET\Respond directory:

global.rev local.rev

Setting Permissions for the Invent and Respond Directories

Teachers at your site need to have full permissions to the \Invent and
\Respond directories so that they can add or change any customized
prompts which they compose.  

Make sure that teachers can read, write, create, and delete files in the
\Invent and \Respond directories, but restrict the teachers' access to the
original twelve files listed to Read-Only — Teachers do not need to be able to
Write to these files nor to Delete the files.  Check the "Assigning Permissions
to DIWE5NET " section on page 35 for the specific permissions for your net-
work operating system.

NOTE:  Student Access to \Invent and \Respond Directories
Students can be limited to Read-Only access to the Invent and Re-
spond directories in the DIWE5NET directory.  Students will save
their work to their own personal diskettes or directory, so they do not
need Write, Create, or Delete permissions for these particular net-
work locations.

Adding Restrictions to the Users Directory
There are two different places where student files end up.  One is meant to
be private — the student's folder in the USERS directory.  The other is meant
to be public, for the turned in documents — the student's folder in the
CLASSES\<teacher>\DOCS\ directory (see the explanation of "File Structure
for Each Teacher at Your Site" on page 37).

When students just choose the Save command (or Save a Copy command),
the program defaults to check the floppy drive and then to this USERS direc-
tory on the server.  When you turn in documents, the files are saved to the
public location in the CLASSES\<teacher>\DOCS\ directory.  You shouldn't
have to navigate around; you should be able to choose the Turn In com-
mand under the Utilities  menu and the documents will go there naturally.

Because of the way the program works, students don't need access to all the
files in the USERS directory, but only those in their own personal directory.  If
you want, you could set network permissions so that students only have ac-
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cess to their own personal directory in the USERS directory.  So, in other
words, at a site where you have RMcfall.002, JStraw.003, and SBego-
nia.004, those users would have these permissions:

• R.L. McFall has FULL permissions to \USERS\RMcfall.002
and no permissions for any other directory within \USERS.

• J. Straw has FULL permissions to \USERS\JStraw.003 and
no permissions for any other directory within \USERS.

• S. Begonias has FULL permissions to
\USERS\SBegonia.004 and no permissions for any other di-
rectory within \USERS.

Setting these permissions could be complex, as you will need to set specific
permissions for every user at your site to a particular directory.  If you need
additional security, however, this is one way to ensure that students do not
have access to the private files of others at your site.

Protecting Network Files
Because DIWE 5.3  requires permissions which allow everyone to write to and
delete files, special precautions need to be taken to ensure that files are not
damaged by someone working with the program's network files in DOS or
Windows.  There are four ways to help make sure that your files are secure:

• Make frequent backups.

All the files in all the directories within the DIWE5NET directory
should be backed up regularly, on a daily basis if possible, so
that no more than one day's work will ever be lost in the case
of a computer malfunction or accidental erasure.

• Set students' permissions ONLY to the DIWE5NET directory and
its subdirectories.

While students need full permissions to files and directories in
the DIWE5NET directory and all its subdirectories, they don't
need access to the entire server.  You can set students' log in
to the network so that they access only the DIWE5NET direc-
tory and its subdirectories with full permissions, but with more
limited permissions to other files on your server.

• Hide the Network directory so that users are less likely to find it.

Hiding the directories or their icons does not provide any true
level of security; however, by hiding files, you can make it less
likely for users to make changes accidentally to files on your
network.  You can use the DOS ATTRIB command to hide
the directories so that they will be less noticeable from the
DOS prompt or in the Windows File Manager (remember YOU
need to be able to find these files however).
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• Mount the server at program launch and unmount upon quitting
the program.

Since students need network permissions to these files only
while working with the program, you can use DOS Batch files
to mount the server with full permissions at program launch,
and unmount the server or reduce permissions when the pro-
gram is quit.
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Chapter

7

Printing & Distributing
Program Documentation

Windows DIWE comes with three printable program guides which should be
printed and distributed at your site.

To print these guides, you'll need a word processing program which supports Rich
Text Format (RTF).  Programs which can open and print the guides include Mi-
crosoft Word 6.0, or 7.0 (for Windows 95), Word Perfect 6.0 or 7.0, Word 97, and
Microsoft Office 97.

If you don't have access to one of these word processors, you can download Ac-
robat versions of the documentation which you can view and print using the Ac-
robat Reader.  You can download the Adobe Acrobat reader from
http://www.adobe.com/prodindex/acrobat/readstep.html.  Adobe Acrobat copies
of these guides are available at http://www.daedalus.com/tech/docs.html.  

Printing RTF Guides

There are three files which you'll need to open and print:

Users.RTF The User's Guide

Instruct.RTF The Instructor's Guide

Admin.RTF The Administrator's Guide

To obtain the best results, open each of the files and follow these guidelines be-
fore printing your guides:

• Set your word processor so that Hidden Text is not displayed.  In Microsoft
Word 6.0 or 7.0, you'll accomplish this by choosing the Options...  command
under the Tools Menu.  Choose the View tab in the dialog which is dis-
played, and be sure that there is no X in the checkbox beside "All" and be-
side "Hidden Text" in the Nonprinting Characters area.
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• Set your word processor so that Hidden Text is not printed.  In Microsoft Word
6.0 or 7.0, you'll accomplish this by choosing the Options...  command under
the Tools Menu.  Choose the Print tab in the dialog which is displayed, and
be sure that there is no X in the checkbox beside "Hidden Text" in the In-
clude with Document area.

• Set your word processor so that Drawing Objects are printed.  In Microsoft
Word 6.0 or 7.0, you'll accomplish this by choosing the Options...  command
under the Tools Menu.  Choose the Print tab in the dialog which is dis-
played, and be sure that there is an X in the checkbox beside "Drawing Ob-
jects" in the Include with Document area.

Distributing the RTF Guides

The print documentation includes all the information which is available in the on-
line program and teacher help files.  Students and teachers at your site can
benefit from access to these guides.  :

The following distribution is recommended:

Who? Which Files? The Guide Names?

Students Users.RTF The User's Guide
Teachers Users.RTF

Instruct.RTF
The User's Guide
The Instructor's Guide

Lab Workers Assisting
Students and Teach-
ers with basic tasks

Users.RTF
Instruct.RTF

The User's Guide
The Instructor's Guide

Lab Workers Assisting
Students and Teach-
ers AND helping to
supervise the site

Users.RTF
Instruct.RTF
Admin.RTF

The User's Guide
The Instructor's Guide
The Administrator's Guide

Site Administrator Users.RTF
Instruct.RTF
Admin.RTF

The User's Guide
The Instructor's Guide
The Administrator's Guide

The User's, Instructor's, and Administrator's Guides may all be reproduced by li-
censed sites, provided that the guide's copyright page is included.  To help pro-
vide students access to the User's Guide, your school might place several copies
of the document on reserve at the library, arrange for students to obtain copies
through a local photocopying service, or place the files in a shared location on
your network which students can access.
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Chapter

8

Setting Up Your Site
DIWE 5.3 comes with one default Instructor (The Administrator), Class (General),
and User (The Administrator).  To set up the program for your site, you will need
to add instructors and classes for those who will use the software.  This section
includes a basic overview of how to log into the program, set your site's adminis-
trator password, and set up and maintain classes.

Logging into DIWE 5.3
1.  Double click on the Maze Icon for DIWE 5.3 (shown left) to launch the pro-

gram.

2. Once the program has started, you'll see a  login screen.  Since The Adminis-
trator exists by default, you can choose the List Names button on this screen
and click the default name: The Administrator.

3. Next, type the default password for the Administrator in the password box.
The password for The Administrator is the following:  admin

4. After you've typed the password, choose the OK button to complete the login
process.  You'll see the program's splash screen and then the Launcher (a
palette of buttons for the basic tools in the program).

Making your Site's Password Secure

Once you've logged in, the first thing you should do is change the Administrator's
password.  DIWE 5.3 's default password for the Administrator — admin — is
powerful since it gives users who know it the ability to log into the system and
makes changes such as setting up classes or changing user passwords.  Since
this guide containing the password is available widely, you should change the
administrative password to something less obvious immediately for security rea-
sons.

To change the Administrator password, follow this process:

1. Choose the Change My Password... command under the Utilities  menu.
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2. In the Change My Password dialog (shown below), type the current adminis-
trator password  (admin) in the upper box  labeled Current Password.

3. Type your New Password in the middle box and then in the lower box to con-
firm the password.  Your password can consist of up to eight alpha-numeric
characters.  Choose a password which you can remember easily but which
will not be easily guessed by students at your site (in order to maintain secu-
rity).

4. Once you've finished, click the OK button to change the password.

Adding New Classes

Next, you'll want to set up new classes for your site by following this process:

1. While logged into the program as The Administrator, with the administrator
password, select the Add New Classes command under the Utilities  menu.  

2. Read the information which appears in the New Class Setup window then
click the Start button to begin adding classes.  Click the Cancel button if you
do not want to add any classes.

3. In the Add New Classes dialog (shown on the following page), type in all the
information requested, including a unique class password.  Instructors must
know this password in order to log in to the system with instructor privileges.
Once you've entered all the information for a class, click the Add Class but-
ton.
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4. Continue the process described in Step Three until all your classes have
been set up.

5. When you've finished adding classes, click the All Done button.

6. Confirm that you have finished adding classes in the Exiting Class Setup
dialog box by clicking on the All Done button. If you have not finished adding
classes, you can click the Cancel button and return to the Set up dialog.

Modifying Class Information

If you need to change the information for a class you've set up later in the term,
because the class name or meeting time is incorrect, you'll use the Modify Class
Info command.  See the next section for information on changing a teacher's
name.

NOTE:  When to Modify Class Information
 Do not try to modify class information while users are logged in to the
class. Wait until everyone has logged out of the class that needs modify-
ing before changing any information.

1. While logged into the program as The Administrator, with the administrator
password, select the  Modify Class Info command under the Utilities  menu.



Windows DIWE 5.3 Administrator's Guide46

2. Read the information which appears in the Modify Class Information dialog
then click the Start button to begin modifying classes.  Click the Cancel but-
ton if you do not want to change any classes.

3. In the upper portion of the Modify Class Information dialog box (shown be-
low), double-click on the name of the class which you want to modify.

4. In the lower portion of the Modify Class Information dialog, type the new or
corrected information in the appropriate spaces.  Click the Change Class but-
ton once you've entered all the changes you need to make to class names
and/or meeting times.

NOTE:  Changing the Spelling of an Instructor's Name
If you need to change the spelling of an instructor's name, use the
Change a User's Information...  command under the Utilities
menu.

5. When you've finished adding classes, click the All Done button.

6. Confirm that you have finished adding classes in the Exiting Change Class
Information dialog box by clicking on the All Done button. If you have not
finished modifying classes, you can click the Cancel button and return to the
Modify Class Information dialog box.
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Setting Class Preferences

You may also want to change the preferences set for the classes at your site. To
set preferences for new student log in, Mail, and InterChange, use the Modify
Class Info... command under Utilities  pull-down menu, and select the teacher's
name and the class which you want to set preferences for.

In the lower portion of the Modify Class Information Dialog (shown opposite), click
in the checkboxes to change the settings for each class.  The defaults for each
class are the most conservative:

Users can register
Default ON, so new students can log in

InterChange pseudonyms allowed
Default OFF, so students cannot use pseudonyms

Students can create InterChange conferences
Default OFF, so students cannot create conferences

Students can create Mail conferences
Default OFF, so students cannot create conferences

Once you finish setting preferences, click the All Done button to save your
changes.

NOTE:  When to Set Class Preferences
 Do not try to set class preferences or modify class information while users
are logged in to the class. Wait until everyone has logged out of the class
that needs modifying before changing any information.

Changing a Teacher's or Student's Name or Password

If you need to change a teacher's or student's registration information — be-
cause of a typo in a name or a forgotten password, you'll use the Change a
User's Information command.  Any instructor or administrator can modify a
user's information — thus teachers can find their own student's passwords in
case a password is forgotten.

1. While logged into the program as The Administrator, with the ad-
ministrator password, choose Change a User's Information  from
the Utilities  menu.

2. Select the name of a student or teacher you want to change in
the Select a Name dialog box which appears, and click the Mod-
ify button.

3. Type the correct or new information in the dialog box which ap-
pears and click the Modify button.  Choose the Cancel button if
you do not want to make a change.

4. Once you have finished making changes, choose the Done but-
ton in the Select a Name dialog box.
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Deleting Student Users

In order to delete test users, log into DIWE as an instructor or as the administra-
tor, and choose the Change a User's Information command from the Utilities
menu.

To remove a student user from a specific class

1. Choose the Change a User's Information command from the
Utilities  Menu.

2. Select the name of a student you want to remove in the Select a
Name dialog box which appears, and click the Classes... button.
(You cannot remove instructors or the Administrator).

3. Select the name of the class which you want to delete the stu-
dent from in the Remove Classes dialog which appears and click
the Remove button.  Choose the Cancel button if you do not
want to make a change.  This change is permanent.

4. Once you have finished making changes, choose the Done but-
ton in the  Remove Classes dialog and then choose the Done
button in the Select a Name dialog box.

To delete a student entirely from the site's records

1. Choose Change a User's Information  from the Utilities  menu.

2. Select the name of a student you want to delete in the Select a
Name dialog box which appears, and click the Classes... button.
(You cannot delete instructors or the Administrator).

3. Select the Delete  button.  

4. Confirm that you want to delete the student permanently by se-
lecting the OK button.  Choose the Cancel button if you do not
want to delete the student.   This change is irreversible.

5. Once you have finished making changes, choose the Done but-
ton in the Select a Name dialog box.

Removing Test Classes

If you've added classes to your site to test the program, you can remove them
from the system so that no new students can log into these classes by following
these steps:  

1. Log into the program as The Administrator

2. Follow the instructions above to remove all student users from the class
by using the Change a User's Information command under the Utilities
menu.
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3. Use the Modify Class Information command under the Utilities  menu
so that users cannot register for the class.  See the "Setting Class Prefer-
ences" section on page 46 for more details.

Once you've completed these steps, no new students will be able to register for
the class.  Because of the complex files and directories which are created and
the permanent changes made to the registration files, there is no way to delete a
class from the system.  However, by following these steps, you can set the sys-
tem so that the class will no longer show up within the system.

Setting Up a New Semester

To start a new semester, your site will backup the current semester and then use
the compressed clean archive to create fresh, new files which you can copy onto
your server.

To make a backup of your current term, make sure no one at your site is using
DIWE, and log in to the General default class as The Administrator.

1. Select the Archive Current Semester... Command from the Utili-
ties menu.  The following dialog will appear:

2. Once you've confirmed that you want to archive your current se-
mester, the program backup your existing semester files.  This
process may take a few minutes.  The following dialog will appear
when the process is complete:

 

3. Choose the Exit command from the File menu to quit DIWE.

4. Make sure that absolutely no one is logged into the program.  Since you
need to delete and replace program files, files will be corrupted if you proceed
with these steps while anyone is logged in.

5. Navigate to the DIWE5NET\Defaults directory on your network fileserver
using File Manager or Windows Explorer (as is appropriate for your operating
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system).

NOTE: If the Defaults directory (or the clean.exe file referred to in step 6) is
missing from your network fileserver, you are probably not using the most re-
cent version of Windows DIWE.  Contact the Daedalus Group, using the con-
tact information inside the front cover of this guide, for instructions on up-
grading.

6. Double-click on the clean.exe file to decompress the archive of
fresh program resources.  The decompressed files will be in their
own CLEAN directory.  The decompression software will default to
the temp file on your local hard drive, but you can type any path
for the decompressed files which you desire.

7. Check the CLEAN directory for the following subdirectories:

1 Classes containing the TAdmin01 Subdi-
rectory, which contains additional
subdirectories

1 Records containing fresh login and user in-
formation files (allclass.dat,
allusers.dat, and reg-
table.dat)

1 Users containing the TAdminis.000
subdirectory

8. Navigate to the DIWE5NET directory on your network fileserver
and delete the following directories:

1 Classes containing subdirectories for every
class which has been set up at
your site during the term

1 Records containing all login and user rec-
ords files

1 Users containing a subdirectory for every
user who has logged in at your
site.

9. Move the fresh directories from the CLEAN folder into the
DIWE5NET directory, being sure to drag each out of the Clean di-
rectory and into the DIWE5NET directory.

NOTE:   DIWE will not function properly if you move the entire
CLEAN directory into the DIWE5NET directory on your fileserver.
You must move the Classes, Records, and Users directories
out of the Clean directory and into the DIWE5NET directory.

10. Log back into the program using the to set up classes and teach-
ers for the next semester.  Use the default Instructor (The Admin-
istrator), Class (General), and User (The Administrator) and enter
the default password which is listed in the printed Installation
Guide.  
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11. To protect your site's security, change the Administrator's pass-
word immediately by using the Change a User's Information
command.  The default password for the program is not secure.

12. To add other instructors and classes, the Administrator must join
the General class and use the Add New Classes...  command.

About the archived class files from previous semesters

The renamed directories from the previous semester are no
longer available to the program, but the term's files can be ac-
cessed, archived, and reused outside of DIWE.  If space on the
network server is limited, instructors should copy all the files they
want to keep onto their own diskettes, and the administrator
should delete those instructors' files.  If you decide to keep these
directories on your server, you can restrict the network permis-
sions to the files so that the files cannot be deleted or modified if
you like.  Additionally, you might restrict who has access to the
files (students may not need access to old class files).

(Note: Instructors might want to archive material students gener-
ated in their classes.  If so, this should be done before the ad-
ministrator begins setting up a new semester.)

Setting up PromptManager

PromptManager allows teachers to customize or write their own question series
for Invent and Respond.  Teachers can use PromptManager in the classroom by
choosing the Run PromptManager command from the Utilities menu.  More in-
structions on how to use PromptManager are included in the Teacher Help file
available on-line in the program, and can be printed out by choosing the Print
Topic...  command from the File menu (or choosing the Print button)  in the Help
File.

Requirements for PromptManager

Some teachers like the option of composing their question files outside the class-
room however— in an office, a teacher workroom, or at home.  The sixth  installa-
tion diskette provides all the files a teacher would need to make a personal copy
of the PromptManager program which will run any IBM-compatible machine  run-
ning Windows 3.1 or higher.  These files are also available in the PM directory
within the DIWE5NET directory on your file server.

NOTE:  Machine Requirements for PromptManager
PromptManager does NOT require a 32-bit operating system; so a
teacher can use this personal diskette on nearly any IBM-compatible
computer, as long as it's also running Windows 3.1 or higher.

Creating Personal Copies of PromptManager

To provide a personal copy of the program for a teacher at your site to use out-
side the classroom, copy the following files from Installation Disk 6  (labeled In-
stallation and Utilities):
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2 pmanager.exe The PromptManager Program
2 pmanager.txt Read-Me File with program docu-

mentation

2 commdlg.dll
2 vbrun300.dll Three program support files
2 cmdialog.vbx

Teachers will need all five files in order to run the PromptManager program.  The
files could be copied to the teacher's floppy diskette, a personal machine, or
other departmental machines.  Teachers will find complete instructions on how to
use the program in the PMANAGER.TXT file.

Running PromptManager Outside of DIWE

To run the program outside of DIWE, the teacher can use the Start Menu in
Windows 95 or the Program Manager in other versions of Windows.  If the pro-
gram and its support files are on a floppy diskette, the teacher would use the fol-
lowing commands:

From the Start Menu in Windows 95 or the Program Manager in other versions of
Windows:

a. Put your  floppy diskette  in your diskette drive.
b. From the Start Menu in Windows 95 or from the File menu in

other versions of Windows, choose the Run. command.
c. Type A:\PMANAGER.EXE (assuming A is the Diskette Drive).

If you don't know the drive, click the Browse button, use the
standard file dialog box to find the diskette drive, and double-
click PMANAGER.EXE

From the File Manager:

a. Put your  floppy diskette  in the diskette drive
b. Choose the A: Drive
c. In this window, double-click PMANAGER.EXE

If the teacher is running the program from another drive, the instructions above
can be modified.  Replace the disk drive information with the Drive and Directory
Location for the copy of PromptManager.

Resetting the Administrator's Password

If you forget the administrator's password for your site or if it is accidentally
changed and needs to be reset, you can use a utility on the sixth installation
diskette to determine the current password for your copy of DIWE5.3.

The program and its support files are on Installation Disk 6 (labeled Installation
and Utilities).  There are three ways to run this program.

From the Start Menu in Windows 95 or the Program Manager in other versions of
Windows:

a. Put Diskette 6 in your diskette drive.
b. From the Start Menu in Windows 95 or from the File menu in

other versions of Windows, choose the Run... command.
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c. Type A:\ADMINPW.EXE (assuming A is the Diskette Drive).
If you don't know the drive, click the Browse button, use the
standard file dialog box to find the diskette drive, and double-
click ADMINPW.EXE

From the File Manager:

a. Put Diskette 6  in the diskette drive
b. Choose the A: Drive
c. In this window, double-click ADMINPW.EXE

Once the program is running, follow these steps to determine your site's adminis-
trator password:

1. Use the directory list on the left side of the dialog box to navigate to the direc-
tory containing the WINDIWE.INI file for  your copy of DIWE 5.3.  This file
should be in the same directory as the WINDIWE.EXE program.  Once you've
navigated to the directory containing the file, its name will appear, high-
lighted,  in the box to the right side of the dialog box.

2. Once the filename WINDIWE.INI is highlighted on the right side of the dia-
log, choose the Show Password button on the lower left side of the dialog
box.  Your site's password will appear in the thin white box on the right.

NOTE:  Protecting This Administrator's Utility Program
Since this utility will allow anyone who uses it access to your site's admin-
istrator login, it's important to keep the diskette in a secure place, and
preferably not to copy this file to the fileserver.
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Chapter

 9

Troubleshooting
This troubleshooting section includes information on the questions most fre-
quently encountered as schools set up the software.   Additional troubleshooting
information is available from the Daedalus Group's WWW page. See the "Getting
Help" section on page 65 for information on ways to access these and other  ad-
ditional resources.

Eliminating Error Messages

The following error messages can appear during program installation, while you're
using DIWE, or while you're using the PromptManager tool.  The messages here
are listed alphabetically.

A file you need is busy

When users try to use tools (either a single tool or perhaps all tools), they see the
error message

A file you need is busy.  Would you like to try again?

     What is Happening?    

This error occurs when the program does not have complete network permissions
to files it needs to use.  You may see the message only when you try to use a
particular part of the program.  That would indicate that permissions are off only
for the particular tool involved.  Alternately, you may see the error message no
matter which tool you try to use in the program.  That situation would indicate that
permissions are off for all the program's support files.   

    Eliminating the Error Message

Check the network permissions and access to the files which DIWE is trying to
access.
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• If you see this error when you are logging in to DIWE, the file which the pro-
gram is trying to access is either in the DIWE5Net\Records subdirectory or in
the DIWE5Net\Users subdirectory.

• If you see this error while you're using the InterChange module, the file the
program is trying to access is in the DIWE5Net\Chat subdirectory.

• If you see this error while you're using the Mail module, the file the program is
trying to access is in the DIWE5Net\Mail subdirectory.

See the section titled "Setting Network Permissions"  on page Error! Bookmark
not defined. for more information on the permissions necessary for DIWE.

ALLUSERS.DAT does not exist

When you try to run DIWE 5.3, you see an error message like the following (with
path and directory information pertinent for your site):

File: X:\DIWE5NET\RECORDS\allusers.dat
does NOT exist. Cannot proceed with program.

     What is Happening?    

DIWE requires access to a list of all the users at your site.  The first thing the pro-
gram needs to do is prepare the list of users so that the user can log into the
program.  This error message occurs when the program cannot access that list of
users.  It can be caused by permissions problems or by a problem in the network
configuration for your site.

    Eliminating the Error Message

There are three possible solutions:

•     Check        Network        Permissions   :  Users must be able to read the file al-
lusers.dat to log in to the program.  If your site's network permissions do
not include read permission, log in will fail.  See the section titled "Setting
Network Permissions"  on page Error! Bookmark not defined. for more
information.

•     Check        Network        Configuration:    The path to the network files for the DIWE
5.3 program are stored in the WINDIWE.INI file located with the copy of
the program you are trying to run.  If the network path in the
WINDIWE.INI file is not accurate, then the program cannot find the re-
sources which it needs.  

1. Open the WINDIWE.INI file.  The WINDIWE.INI file is an
ASCII text file which you can open with any basic word proc-
essor — you could open it with the Write word processor in
DIWE5.3, or you might use the Notepad or WordPad pro-
vided in Microsoft Windows.

2. Look for the NET= information in the file — It should be lo-
cated on the third line of the file.

3. If necessary, edit the NET= information so that it accurately re-
flects the location of your DIWE5NET files.

4. Save this file, and try launching DIWE 5.3 again.
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•     Check         Network         Access         and         Existence:     The files installed in the
DIWE5NET directory are required to run the program, even if you intend to
run the program as a stand-alone test version on a single machine.  Be
sure that the DIWE5NET directory files have been installed and that your
workstation has access to these files.

Cannot Create Directory

When new users try to log in, they enter their names and passwords, confirm
their passwords, choose a class to register for, and then see an error similar to
this one:

Can't Create Directory:
X:\Software\Programs\English\DIWE5NET\Classes\TADMIN00\DO
CS\NStudent.006

Where the path to the DIWE5NET directory and the name of the Teacher and
new user are appropriate for your site.

     What is Happening?    

This error occurs when the DIWE5NET folder for your site is installed too deep on
your fileserver for DIWE to function properly. The Windows operating system , like
DOS, is limited to creating a path of more than 64 characters long. Since DIWE is
trying to create a filename with a path of 70 characters in this example, the new
user login fails.

    Eliminating the Error Message

Fixing your site's files so that new users can register for all classes requires three
steps:

1. You'll need to move your DIWE5NET directory closer to the root on
your server — because of various needs in the software, you'll find
that the program will work best if you can place the DIWE5NET folder
actually at the root. So using the example, move the directory to
X:\DIWE5NET.

2. Edit your site's WINDIWE.INI files to reflect the new path to the
DIWE5NET directory. If you have the DIWE5 directory only on your
server, you'll only need to edit one file; if you have copied the DIWE5
directory to all your workstations to improve performance, you'll need
to change the WINDIWE.INI file on all every machine. To edit the
WINDIWE.INI file, follow these steps:

a. Open the WINDIWE.INI file in NOTEPAD (the INI file is a text
file).

b. Look for the NET= information. In the example, the
WINDIWE.INI file would include the line:

NET=X:\Software\Programs\English\DIWE5NET
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c. Edit this line to match the new path to your DIWE5NET direc-
tory. In the example, since we've moved the directory to the
root, this would be the new line:

NET=X:\DIWE5NET

d. Save and close the WINDIWE.INI file.

3. Adjust your network permissions so that all users have the necessary
permissions to access the new location of your DIWE5NET directory.
See the section titled "Setting Network Permissions" on page 35 for
more information on setting permissions properly.

4. Try using Windows DIWE again, and new users should be able to log
in.

NOTE:  Login Fails because "ALLUSERS.DAT does not exist"
If you see the error message, "ALLUSERS.DAT does not exist," ei-
ther the NET information you changed in your WINDIWE.INI file isn't
right or the network permissions need reset to provide access the
new location of the DIWE5NET folder. See the troubleshooting in-
formation on this error message on page 56.

Cannot open message index file

When users try to open InterChange or Mail, they see one of these error mes-
sage

   InterChange:   
Cannot open message index file:
diwe5net\classes\instructor\chat\main\main.idx

     Mail:   
Cannot open message index file:
diwe5net\classes\instructor\mail\main\main.idx

Where the path to the main.idx file would be the path to the file on your
network (including any additional directory names and the specific instruc-
tor's directory name).

     What is Happening?    

This error occurs when the program does not have complete network permissions
to files it needs to use, specifically the MAIN directory in either the  instructor's
CHAT or MAIL directory.  

    Eliminating the Error Message

Check the network permissions and access to the files which DIWE is trying to
access.  

• If you see this error while you're using the InterChange module, the file the
program is trying to access is in the DIWE5Net\Chat subdirectory.

• If you see this error while you're using the Mail module, the file the program is
trying to access is in the DIWE5Net\Mail subdirectory.
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See the section titled "Setting Network Permissions"  on page 35 for more infor-
mation on the permissions necessary for DIWE.

Directory is not writeable. Please check permissions.

When you try to install the program from the installation diskettes, you see the
following error:

Directory is not writeable. Please check permissions

     What is Happening?    

The program's installer is unable to create the files and directories necessary for
the program.  

    Eliminating the Error Message

First, check the network permissions for the locations on the fileserver and the
workstation you have chosen as the destination for the DIWE5 directory and the
DIWE5NET directory.    You should log onto the fileserver and workstation with full
network permissions in order to create and write the necessary files to these di-
rectories.  See the section titled "Setting Network Permissions"  on page 35 for
more information.

If network permissions are correct, try choosing a different destination for your
files — specifically, be sure NOT to include DIWE5 as a part of the path for the
workstation and network files.  For example, if you had been entering
F:\Programs\DIWE5 as the path for the network files, try entering F:\Programs
as the path instead.  

Failed to launch help

When users choose the Program Help command under the Help menu or the
Help Using Help command, they see the following message:

Failed to launch help.

     What is Happening?    

This error occurs when the program is unable to launch the Help program,
WINHLP32.EXE.  

    Eliminating the Error Message

Make sure that the program is available to the machine and that its location is
included in the PATH statement in your AUTOEXEC.BAT file.

Improper Installation

When you try to run DIWE5.3, you see the following error:

Improper Installation.
Win32s requires Win32s.exe
in 32s16.dll to run.
Reinstall Win32s.
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     What is Happening?    

You'll see this error message if you try to run DIWE 5.3 on a workstation which is
not running a 32-bit operating system.  

    Eliminating the Error Message

Use the installation diskettes to install the system files necessary to run DIWE5.3.
See the "Installing WIN32S System Resources Only" section on page 24 for in-
structions.

Invalid Page Fault or Unhandled Exception at Program Launch

Some sites are seeing the following error at program launch:

WINDIWE caused an invalid page fault in module
WINDIWE.EXE at 0137:004019DE.

OR
Program not working at all -- Unhandled exception de-
tected code: 0xC0000005 WINDIWE.EXE.

    Eliminating the Error Message

This error seems to be caused by corrupt, incomplete, or outdated system files
which are necessary to run Windows DIWE.   Try reinstalling the Win32s files for
the program and relaunching. See the "Installing WIN32S System Resources
Only" section on page 24 for instructions.

No Prompt Entered (In PromptManager)

When you add a question to the series of questions you're writing in
PromptManager, you see a message box which says the following:

No Prompt Entered.

What you're seeing is part of a safeguard in the software built in to make sure
that teachers do not write an invalid, or corrupt, series of questions.  The Invent
and Respond Modules in DIWE will fail if any series of prompt questions includes
a blank question — that is a question without any text. PromptManager was de-
signed so that you could never write one of these series which would fail.

     What is Happening?    

When you choose the Next or Previous button, PromptManager checks to see if
the question you've been working on is valid. If it's not — if there's no text there
— you see the "No Prompt Entered" message. In other words, whenever you
have a blank question on screen, whether because you've just added a new
question or because you've deleted the text from a question which already ex-
isted, AND you then try to move to another question, you'll see the alert mes-
sage.

The existing questions which you've entered are still in the series — none of your
text is missing, and PromptManager is working as it was designed to make sure



Windows DIWE 5.3 Administrator's Guide61

that the questions you create will work when your students use them in the class-
room.

    Eliminating the Error   

When you see the alert message, you can either delete the blank question and
move to another record, or you can enter a draft of your question (or a temporary
question), move to the previous or next question, then move back to the draft or
temporary question and revise it.

Was Not Found

You choose the Invent button on the Launcher or the Invent command under
the Activity  menu. A file-open dialog box appears, and you can choose the
name of the file you want to open. Instead of seeing the Invent Prompt window
appear, you see the following:

In Windows 95

you see an error message with a red X, and the message "was not
found."

In other versions of Windows

you see a Stop sign and the message "was not found."

After the error message, the file will not be opened.

     What is Happening?    

There is a slight difference between the format for Invent and Respond prompts
for DOS DIWE and for Windows DIWE. If you try to open a DOS prompt series
using Windows DIWE, you'll see the error messages listed above.

    Eliminating the Error Message    

Convert your DOS prompts to Windows prompts in order to open them in Win-
dows DIWE.  by adding one line to the files. The files for DIWE5 follow this for-
mat:

1st Line: the series name (no more than 30 characters)
2nd Line: a tag indicating whether the student's topic will be inserted.

The tag will be either TOPICSON
or TOPICSOFF

3rd Line: the first question in the series

The old format for Invent and Respond files did not include this second line, so
you'll need to add it to the old DOS files. Nothing else about the Invent and Re-
spond files, however, will need changed. If the files worked in DIWE4, all you'll
need to do is add the 2nd line to them to make them work in DIWE5.

To convert your DIWE4 files, you can follow these steps:

1. Open the DIWE4 Invent or Respond file in any word processor — you can
use the WRITE word processor in DIWE, or you can use a separate word
processor such as Microsoft Word or Word Perfect.
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2. Move your cursor to the end of the first line of the file you've opened. In
the following lines from an example file, you'd move your cursor to the
right side of the number 1:

Explicating 1
What part of * intrigues you the most? What aspect
of * would intrigue your reader the most? What part
of * will you explain?

3. Press the <Enter> key to add a new line; your cursor should be at the
beginning of the second line. The example file would look like the follow-
ing:

Explicating 1

What part of * intrigues you the most? What aspect
of * would intrigue your reader the most? What part
of * will you explain?

4. Add the TOPICSON or TOPICSOFF tag to the second line.

Choose TOPICSOFF
If you are converting an Invent file where students DO NOT insert their
paper topic (one without the asterisks [*] included) or if you are converting
any Respond file

Choose TOPICSON
If you are converting an Invent file where students DO insert their paper
topics (one with the asterisks [*] included

The example file is one where students DO insert their topics, so the
TOPICSON tag is used:

Explicating 1
TOPICSON
What part of * intrigues you the most? What aspect
of * would intrigue your reader the most? What part
of * will you explain?

5. Once you've added the second line with the TOPICSON or TOPICSOFF
tag, save the file as ASCII text (check your word processor's help file for
instructions on how to save a file as text). Your file will need to follow DOS
naming conventions by using an eight character filename consisting of
letters and/or numbers. Use the *.INV filetype if you are saving an
INVENT file; Use the *.REV filetype if you are saving a RESPOND file.

6. Place your saved file on the fileserver in the DIWE5NET\INVENT\ direc-
tory if it is an Invent file or in the DIWE5NET\RESPOND\ directory if it is a
Respond file. The file should be available within DIWE5 once it's added to
the proper directory.
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Eliminating System Conflicts

Launcher Graphics and Windows Display Incorrectly

Some sites see misaligned buttons on the Launcher – the buttons appear on top
of the words in the dialog box and the words are cut off on the bottom and right.
There is similar misalignment in windows in parts of the program like Mail and
BiblioCite.

     What is Happening?    

The program has a system conflict with some video displays which are set at a
resolution higher then the recommended 640 by 480 display resolution.

    Eliminating the System Conflict

If you change the screen resolution using the Display control panel in your Win-
dows operating system, the dialog boxes and windows should appear correctly.
The specific procedures you'll follow to change your screen resolution will depend
upon the version of Windows you're using. Check your Windows documentation
or on-line help for details.

No Files Listed in Invent or Respond

You choose Invent or Respond; then you choose the New button from the New-
Open-Cancel dialog box which appears. A File-Open dialog box appears — but
instead of seeing a list of the Invent or Respond questions, you see a blank
folder. There are no files, no drive selected, and no directories shown. To use the
program, you have to choose a Drive, navigate to the DIWE5NET\Invent direc-
tory, and choose the file you want to begin work on.

     What is Happening?    

Windows DIWE requires a drive letter in the NET= path in the Windiwe.ini file. You
see the empty File-Open dialog box when your Windiwe.ini file uses a Univer-
sal Naming Convention (or UNC) name rather than using a drive letter.

UNC names are what you'd see in the Windows Explorer in Windows 95. This
would be an example of the NET line from an INI file which is NOT working:

NET=\\English\Programs\DIWE5NET

In that example, "English" is the name of the server/machine on the Windows
95 network and "Programs"  and "DIWE5NET" are the names of directories on
that machine. Instead, your NET line needs to look something like the following:

NET=X:\Programs\DIWE5NET

    Eliminating the System Conflict   

If you change the NET line in your WINDIWE.INI file from using that UNC protocol
to using a drive letter, the files should show up automatically in Invent and Re-
spond. The fix may require a few steps for you:
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1. You'll need to assign a drive letter to the shared directory, and connect
your workstations to the server using this drive letter. Check your on-line
help for the Windows operating system for information about assigning a
drive letter.

2. Edit the INI file so that the NET=\\SERVER\DIRECTORY\DIWE5NET
(generically speaking of course) would be more like
NET=X:\DIRECTORY\DIWE5NET. You'll need to use the drive letter and
path to your DIWE5NET file, of course.

3. Repeat these steps for all the machines which have a copy of the DIWE5
directory on them; in other words, you will have to set drive letters and
edit the WINDIWE.INI file on every workstation if you've installed the pro-
gram on the workstations. If you only have the DIWE5 directory on your
network file server, you will only need to edit the file on the server, but you
will need to ensure that your workstations are connected to the network
using the drive letter you've included in your INI file.
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Chapter

10

Getting Additional Help
with DIWE
What to Do Before Sending in a Request

1. If you have    Internet    access, check the frequently asked questions and  trou-
bleshooting information on the Daedalus Group WWW page, especially for
information written after the publication of this guide.  The Daedalus Group
web page is available at  http://www.daedalus.com/

2. If you have     e-mail   access, consider asking on the TEACH e-mail discussion
list.  The TEACH e-mail list links teachers in conversation about teaching,
problem-solving, and troubleshooting. To subscribe to TEACH,

send an e-mail message to listproc@daedalus.com
include the subject line: sub teach
include the single line message:

subscribe teach your-firstname your-lastname
for example, subscribe teach Jerri Stephens

Once you've subscribed, send your questions, insights, and success stories
to teach@daedalus.com

3.  If you have     e-mail        access,        but        no         WWW        access   , you can access Daedalus
HelpSheets which duplicate the information available from the WWW pages.
Send an e-mail message to helpsheets@daedalus.com with the subject
line INDEX to see a list of the troubleshooting sheets currently available.
Messages sent to this address automatically return Help Sheets with informa-
tion on using the Daedalus Integrated Writing Environment.  The Help Sheet
you receive depends upon the subject line for your message.  

4. If you have     no       Internet        access   , you can fax 1-512-452-5206 for details on
obtaining the latest troubleshooting information by fax or postal mail.
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Sending a Request

If you have questions about Windows DIWE, locate the SYSINFO.DAT file for the
machine you have questions about.  This file was installed with the software and
records details about your hardware and the location of DIWE 5.3 on your net-
work.   Here's an example of the information from a SYSINFO.DAT file:

DIWE 5.3 Installation Notes -- System Configuration
Installation Date: 12-19-1997
Installation Time: 19:40:26

Your Operating System

Pentium Processor
Network:
Network Driver:
Mouse: Standard mouse
Mouse Driver: mouse.drv
Video = VGA
DOS version: 7.0
Base Memory Size:  640
Extended Memory Size: 15360
Boot drive:  C:
Windows version: 3.95
OS = Windows 95

DIWE 5.3 was installed on your workstation in C:\DIWE5
Network Items were installed in c:\DIWE5NET
The Uninstaller was NOT installed.
Winhelp.exe was found -- C:\WINDOWS\WINHELP.EXE
Winhlp32.exe was found -- C: \WIN32S\WINHLP32.EXE
The path to the found help files was added to both
     the buffer and to Autoexec.bat

By providing this information, you will include the details necessary to answer any
questions you may have quickly.  In addition to this information, the file includes
questions about your site and the situation you've encountered.  

The file is an ASCII text file which you can open with any basic word processor —
you could open it with the Write word processor in DIWE, or you might use the
Notepad or WordPad provided in Microsoft Windows.

Ideally, you can add the details about your question to this file and then contact
The Daedalus Group by one of the methods mentioned below.  If you cannot
locate the SYSINFO.DAT file, you can use the form on page 67.

Once you have gathered the information on your machines, you can

• fax it to 1-800-388-8152,
• send it in an e-mail message to  help@daedalus.com
• call the Daedalus Group at 1-800-879-2144.
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Windows DIWE Customer Support Request Form

As you fill in the form, please be as specific as possible about your lab's set-up
and the details of the situation.

Name:

School:

Phone Number:

Fax Number

E-mail Address

What is the Brand, Model, & Clock Speed  for your workstations?

What is the Brand, Model, & Clock Speed  for your fileserver?

What is your Networking Hardware? (For example, Phone Net, Token Ring, Eth-
ernet , and so on)  

What is your Network Operating System? (For example,  Novell, NT, Lantastic,
and so on)  

What other software is running on your machines while you use  DIWE 5?
Please be sure to include information about any file management programs you
might be running along with DIWE and any memory-resident programs (or TSRs).  

    Description       of        Situation   

1.  Include a sense of the     events      leading        up       to        any        problem     . In other words,
exactly where in the program do you have difficulty?   What works? What
conditions seem to enable or disable the problem?
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2. Indicate     how         universa    l the situation is. For instance, is the problem
showing up on all machines or only a few? (If so, are the machines differ-
ent in any way?) Is it occurring in only some classes or to some students?
Does it happen only at certain times of day?

3. Specify     how        often     the problem occurs — does it happen all  the time?
sporadically? Does there seem to be any pattern?

4. Record     any        error         messages    you see exactly as they  appear on screen.
Indicate what you were doing just before the error as well.
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